
   
 

 1  
 

LAUSD Job Aid for Microsoft Word 

Accessibility in Microsoft Word is crucial for the Los Angeles Unified School 
District (the District) because it ensures that all students, parents, and 
community members, including those with disabilities, can access and 
understand important information. This promotes inclusivity, equal 
opportunities, and compliance with legal requirements like the Americans 
with Disabilities Act (ADA) and Section 508 of the Rehabilitation Act of 1973. 
Additionally, accessible documents improve overall usability, making 
information clearer and easier to navigate for everyone.  

Resource: Effective Communication 

Document Accessibility Checker 
The accessibility checker helps identify and fix accessibility issues, such as 
missing alternative text (the brief text description of images that are read out 
loud), poor color contrast, and improper use of headings and tables. By 
addressing these issues, you ensure that your content is readable and 
navigable for users with visual impairments or those relying on assistive 
technologies. 

Use the built-in MS Word Accessibility Checker to identify and address 
accessibility issues. When using the Accessibility Checker the documents are 
then inspected, and errors are categorized with suggested solutions once the 
error is selected. Real-time feedback is available to show as issues are 
resolved. Test your document with assistive technologies such as screen 
readers to ensure compatibility. Remember to Save your work to preserve the 
accessibility structure! 

The Check Accessibility tab (see below), which opens the “Accessibility 
Assistant” window with errors sectioned off by category type. You may also 
select specific support such as Alt Text, Navigation Pane, Focus and Options: 
Accessibility only. “Accessibility Assistant” windowpane will generate possible 

https://www.lausd.org/cms/lib/CA01000043/Centricity/Domain/821/DOJ_effective-communication.pdf


   
 

 2  
 

solutions for review and approval that address each error category and 
provide alternatives or “quick fix” recommendations. 
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Screen Readers 
Screen readers are a type of assistive technology designed for people who 
are blind or visually impaired. They convert text and image content on a 
computer screen into speech or braille output. Screen readers work by 
interpreting the information on the screen and providing commands through 
keyboard shortcuts. Here are a few recommended screen reader applications 
and guides that will help you maneuver through documents.   

 

 
• JAWS Quick Reference Guide 
• NVDA Quick Reference Guide 
• VoiceOver User Guide 

Color Contrast 
Ensure sufficient color contrast between text and background to improve 
readability. Use accessible color combinations that comply with WCAG (Web 
Content Accessibility Guidelines) Standards. Accessibility check for color is 
necessary where the document has a variety of different colors. 

Make sure your contents color contrast passes by using the WebAIM Color 
Contrast Checker. Test your color contrast by identifying the two-color fields, 
“Foreground Color” (text) and the “Background Color”. A color contrast ratio of 
4.5:1 is recommended for regular text. Manually enter Hex values or use the 
color picker by clicking the Color Picker box next to each field and use the 
dropper. 

https://dequeuniversity.com/assets/pdf/screenreaders/jaws.pdf
https://dequeuniversity.com/assets/pdf/screenreaders/screen-reader-nvda.pdf
https://support.apple.com/guide/voiceover/welcome/mac
https://support.apple.com/guide/voiceover/welcome/mac
https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/
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Test results will show if the contrast passed or failed in the following three 
categories: 

• Normal Text (12pt) 
• Large Text (16pt or larger) 
• Graphical Objects 

Font 
Fonts play a crucial role in accessibility because they impact readability and 
comprehension. Clear, legible fonts ensure that text is easily readable for 
people with visual impairments or dyslexia. Choose simple fonts like the 
District’s branding fonts: Larsseit, Poppins, and Lato. Do not use decorative 
fonts with scripts of decorative styles as these are harder to read. Make sure 
font characters are appropriately spaced out and do not have any 
connections or overlap. Ensure your font size is 12 points or larger and avoid 
the use of all capital letters, excessive italics or underline. 

  

 

https://www.lausd.org/branddownloads
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Typography 
Both legibility and readability are crucial for effective communication in 
design and typography. Ensuring high legibility and readability helps make 
text accessible to a wider audience. 

• Legibility focuses on the clarity of individual characters. 

• Readability focuses on the ease of reading and understanding the text. 

Test height, similarities decorative elements with lower case “i”, lower case “l”, 
the number “1” upper case “L”. Another test is comparing lower case “q” and 
lower case “p” to determine how close the characters align. 

 

Times New Roman is not accessible because font characters are similar, have 
decorative ends, and decorative elements connect. 

  

Poppins font ensures characters are all different, there are no decorative 
elements and has sufficient spacing between characters. 



   
 

 6  
 

Headings 
Headings allow screen reader users to navigate through the document 
efficiently. They can jump from one heading to another, making it easier to 
find specific sections. Headings provide a logical structure that helps organize 
content, and when done properly, the heading structure can be exported to 
"Save As" an Adobe PDF. 

Note: Avoid using the "Title" style. Enlarging, Underlining or bolding the text 
does not make the title of the document accessible. The title of your 
document should be labeled as “Heading 1”. 

• Set meaningful titles for your document. 
• Utilize heading styles (Heading 1, Heading 2, etc.) for hierarchical 

organization. 
• The Styles Pane is in the "Home" tab of the ribbon. 
• Ensure headings accurately describe the content they precede. 

 

Table & List Structure 
Proper use of tables and lists promotes inclusivity and enhances usability by 
maintaining clear structure and hierarchy. Use the built-in “Table” feature 
under the Insert tab instead of creating tables with tabs or spaces. Provide 
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clear headers and rows, avoid merging cells, and use simple table structures. 
For long tables, apply “Repeat Header Rows” under the Table Layout tab. Use 
built-in bullets or number list styles to ensure proper reading order for screen 
readers and keep list formatting consistent. Avoid mixing different list styles in 
the same document. 

  

The above tables have been manually created; therefore, the screen reader 
will not associate the course subjects with the correct student enrollment 
number. 

   

These tables use the appropriate table structure. The table headers will be 
read by the screen reader and relate it to the corresponding columns and 
rows. 
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Alternative Text (Alt Text) 
Alt text provides descriptions for images, helping people with visual 
impairments who use screen readers. It also displays if the image fails to load, 
ensuring effective communication. To add alt text, right-click on an image 
and select the “Alt Text” tab. Provide concise, descriptive text that conveys the 
image’s meaning and relates to the surrounding content. The “Generate alt 
text for me” button uses AI to create descriptions, but not all images are 
recognized accurately. For decorative images, mark them as “Decorative” to 
avoid unnecessary screen reader descriptions or errors. 

 Note: Alt Text is only accessible when using a screen reader. The image 
description is not available to those who are not using screen readers. 
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Screen readers or other assistive technology will announce “image of a 
classroom with desks and a chalkboard.” No need to add the pre-fix Image, 
photo, graphic, etc. 

Descriptive Text for Multimedia 
Descriptive Text provides additional context and clarity for surrounding 
content. Using descriptive text for links, titles, and captioned images will 
ensure that all individuals have equitable access to the information being 
shared. Use descriptive text for hyperlink anchors that clearly and accurately 
describe the link's destination or title of the website. Avoid generic phrases like 
"click here" or "read more," as they provide little context to users who navigate 
by screen readers. Providing alternative formats such as external transcripts, 
captions and creating inclusion for Deaf or Hard-of-Hearing individuals. Link 
to external transcripts or provide them directly within the document. 

 

Using hyperlinks in MS Word instead of full web addresses enhances 
document readability and professionalism by keeping the text clean and 
uncluttered. Type concise text description in the “Text to display” field and 
enter the web link in the “Address” field.  
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Document Title 
Adding a document title is crucial for accessibility, as it creates an 
introduction for someone who is using assistive technology. Follow these 
quick easy steps to ensure your document is accessible from the start.  

Step 1: Go the “File” menu and select “Info”. 

Step 2: From the Properties section select “Add a Title” and add your title. 

• “File Name”: Used for organization and location of the document. 
• “Title”: Used for understanding content upon opening, and curial for 

screen readers.  

 
Converting Word to PDF 
Need to save your file as a PDF? Properly saving a file as a PDF is crucial for 
accessibility because it preserves the document’s structure, which is essential 
for screen readers and other assistive technologies. Follow these steps to 
ensure the changes made in Word transfer into an accessible PDF. 

Step 1: Select “File” tab.  

Step 2: Select “Save As”. 

Step 3: Choose “PDF” in the Save as type dropdown. 

Step 4: Once PDF is selected, click on “Options”. 
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Step 5: Select the following items from the “Include non-printing information” 
section and click “OK”. 

• Create bookmarks using: Headings 
• Document properties 
• Document structure tags for accessibility  

Step 6: Select “Save“ to convert your Word file into a PDF.  

Do NOT select the “Print to PDF”, accessible document structure is lost with 
this option. 
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 Resources 
Below is a list of Microsoft support sites and videos for additional information.  

• Microsoft Support-Accessibility Checker 
• MS-Rules for the Accessibility Checker 
• Screen Reader Support for Word 
• Microsoft Support-Color Contrast 
• Microsoft Support-Headings 
• Microsoft Support-Tables 
• Microsoft Support-Alt Text 
• Microsoft Support-Hyperlink 

Remember, creating accessible content benefits everyone! Make sure you 
apply these best practices to your MS Word documents. If you have additional 
questions or need ADA Technical Support, please contact the Office of ADA 
Compliance by email at ADA-info@lausd.net. 
 

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.office.microsoft.com/en-us/article/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/screen-reader-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c
https://support.microsoft.com/en-us/office/use-color-and-contrast-for-accessibility-in-microsoft-365-bb11486d-fc7d-4cd9-b344-16e2bc2a2387
https://support.microsoft.com/en-us/office/word-use-built-in-headings-and-styles-4186b453-5580-43aa-9aa1-43c251eebf26
https://support.microsoft.com/en-us/office/video-create-accessible-tables-in-word-cb464015-59dc-46a0-ac01-6217c62210e5
https://support.microsoft.com/en-us/office/everything-you-need-to-know-to-write-effective-alt-text-df98f884-ca3d-456c-807b-1a1fa82f5dc2
https://support.microsoft.com/en-us/office/create-or-edit-a-hyperlink-5d8c0804-f998-4143-86b1-1199735e07bf
mailto:ADA-info@lausd.net

